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PART 1: ON1 PHOTO KEYWORD AI

ON1 Photo Keyword AI is a simple-to-use organization tool designed to ease the process of keywording 
groups of photos. Using the power of advanced AI technology, Photo Keyword AI applies keywords 
automatically based on photo content, letting you bypass the often time-consuming task of manually 
tagging photos so that you can find them easily later.

Photo Keyword AI’s automatic keyword generation uses advanced machine learning algorithms that scan 
each image, recognizing over 800 objects and photo elements. Related keywords are added automatically, 
ensuring more accurate search results, and all this is accomplished locally, using on-device intelligence, 
without uploading your photos to the cloud.

The app can also detect faces, estimate age and gender, determine location using GPS metadata, and 
classify photos based on photographic traits such as key, contrast, vividness, focal length, and predominant 
color. These features enable photographers to quickly find the images they need in their extensive photo 
collections.

Photo Keyword AI doesn’t just automatically tag your photos with keywords. It is also a lightning-fast 
browser built to help you view, organize, and cull your photos. With complete metadata support, including 
nested keywords, descriptions, EXIF, IPTC, and XMP support, Keyword AI ensures that all relevant 
information is captured and accessible in the app. You can even start at the import stage, using Keyword 
AI’s full-featured import tools to select photos, designate their destination, rename them, and add metadata 
simultaneously. 

You can also use Photo Keyword AI to help finding duplicate and similar photos in your existing libraries, 
freeing up valuable storage space. Its powerful Export feature lets you save copies of your photos in 
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different formats, with complete file-naming and metadata controls; and you can even add watermarks. 
For photographers seeking to showcase their work, ON1 Photo Keyword AI provides a fully color-managed 
workflow for printing photos, including the ability to preview them with soft proofing, print packages, and 
contact sheets. Then, when you’re ready to pass your culled and tagged photos on to your photo editor, 
Keyword AI’s automatic XMP embedding ensures that all your work is viewable and searchable in other 
photo applications like Adobe Lightroom Classic, Photoshop or Capture One.

ON1 Photo Keyword AI supports most modern photo file formats, including raw photos from over 800 
cameras. It has a versatile search functionality that lets you type a word or phrase to search any metadata 
field. You can also search by star and color rating, number of faces, age and gender, file type, camera 
settings, size, and more. 

Getting Help
You can find an extensive collection of 
video tutorials and help documents in 
the Help section of the ON1 website 
(on1help.zendesk.com). This is the 
best and quickest way to dig into the 
entire ON1 workflow and discover new 
techniques that will help you with your 
photo editing and organizing. There, 
you can search our Knowledge Base for 
frequently asked questions, common 
issues and more. 

Inside ON1 Photo Keyword AI, you 
can use the Learning Hub to directly 
display videos for getting started with 
the app, search the ON1 online help 
system—including with and online chat 
assistant—and the ON1 Shop, where 
you can purchase add-ons and courses 
for Keyword AI. If you’re a member of 
the ON1 Plus community, you’ll also 
find access to Plus content and loyalty 
reward downloads.

The Learning Hub is accessible via the 
Help menu or from the Help icon at the 
bottom of the left bumper panel.  

The Learning Hub is available directly from within ON1 Photo Keyword AI, and includes links 
to videos (which can be played directly in the Hub window), ON1’s online help system, and 
the ON1 store.

http://on1help.zendesk.com
https://on1help.zendesk.com/hc/en-us
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System Requirements

MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6, 11 or 12
Windows 10 or 11 
current maintenance releases, 64 bit only

macOS 12 and above
Windows 11 
current maintenance releases, 64 bit only

PROCESSOR Intel or AMD processor, 2GHz or faster, or Apple Silicon processor

RAM 8 GB 16 GB or more

HARD DRIVE 3 GB for installation 3 GB for installation and SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

MOBILE APP Apple iPhone or iPad with iOS 14 or 
higher; Android phone or tablet with 
Android 10 or higher.

current maintenance releases, 64 bit only

Apple iPhone/iPad with iOS 15 or higher; 
Android phone or tablet with 64-bit 
Android 11 or higher.

current maintenance releases, 64 bit only

INTERNET A high-speed internet connection and active account for ON1 Cloud Sync, activation, 
auto-update checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports pressure-sensitive tablets for controlling brush size and/or opacity, and 
external control devices (such as those from LoupeDeck and El Gato). Supports ICC/
ICM profiles for camera input, display, soft-proofing, and printing. Hardware display 
calibration tool is recommended.

Keyword AI 2023 also supports many plugins designed for use with Adobe 
Photoshop.

LANGUAGES 
SUPPORTED

English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch
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Installation
To install ON1 Photo Keyword AI, you must 
first download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to your 
ON1 account. The Application Manager will then 
communicate with the ON1 servers, and display 
any apps you already have installed, as well 
as any newer apps that are available for your 
account.

The Application Manager is available on the 
ON1 website in the help desk section (on1help.
zendesk.com), or via this link. 

Your license lets you install Keyword AI on two 
computers. When you enter your ON1 account 
info, Keyword AI communicates with the ON1 
activation server and registers your software for 
that computer.

If you wish to move your copy of Keyword AI 
from one registered computer to a new one, and 
you are not going to be using the older machine, 
it is best to sign out of the old computer first. 
Open Keyword AI and select Sign Out from 
the Help menu. This will deactivate Keyword 
AI 2023 on the current machine, and you can 
install and sign in on another machine from the 
Application Manager.

FREE TRIAL VERSION

ON1 Photo Keyword AI can also operate as 
a fully featured trial version for 15 days from 
when you first launch it. This gives you time 
to evaluate the product and see if it fits your 
needs. To install Keyword AI as a trial, click on 
the Free Trials label in the Application Manager, 
and click on the Install button. The Application 
Manager will display the number for days left in 
your trial; to purchase Keyword AI, click on the 
Buy button in the Free Trials section.

The ON1 Application Manager, showing the login screen, the available apps for 
your account, and the currently installed apps.
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INSTALLATION LOCATIONS
On a Mac, the application is installed in the ON1 Photo Keyword AI folder in the Applications folder. 

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

On Windows systems, the application and support files are installed in the ON1 Photo Keyword AI folder in 
the \Program Files\ON1\ directory. 

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Photo Keyword AI on your computer, the installation process will move 
over any cataloged folders, albums, and metadata presets. 

BACKING UP YOUR KEYWORD AI CONFIGURATION

ON1 Photo Keyword AI includes a back-up and restore function for most of the app’s settings, presets, 
extras, all edits, made to any image and much more (your photos are not backed up, however). To learn 
more about this feature, see “Backing up Your Work in Photo Keyword AI” on page 85.

Launching ON1 Photo Keyword AI
To launch Keyword AI 2023, with access to all modules, follow these steps:

MAC

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Photo Keyword AI folder.

4.	 Double-click on the ON1 Photo Keyword AI application icon.

You can add ON1 Photo Keyword AI to your dock for easy access by clicking and holding the icon in the 
dock and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Photo Keyword AI.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Photo 
Keyword AI from there.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including your email address, password, and notifications.

If you have issues related to installing or activating Keyword AI, please contact ON1 customer support, 
which can be reached by clicking on the ON1 website’s Support tab (https://on1help.zendesk.com).

https://on1.com/login/
https://on1help.zendesk.com
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Uninstalling ON1 Photo Keyword AI
To uninstall ON1 Photo Keyword AI, first deactivate your product: open ON1 Photo Keyword AI and select 
Sign Out… from the Help menu. (This will allow you to transfer your license to another computer.)

On a Mac, go to the Applications/ON1 Photo Keyword AI/Documentation folder, and double-click on the 
Remove ON1 Photo Keyword AI application.

On a Windows computer, go to Control Panels, and under Programs select Uninstall a program. In the list 
that comes up select ON1 Photo Keyword AI and then click on the Uninstall button.

Working with Files
ON1 Photo Keyword AI can view and open the following file types, in RGB color mode, at either 8 or 16 
bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC)

•	 ON1 Photo format (ONPHOTO) 

Keyword AI can export files in PSD, PSB, TIFF, JPEG, DNG and PNG format.

NOTE: ON1 Photo Keyword AI can also view and catalog most standard video 
formats. While you cannot play or edit video from within Keyword AI, you can 
perform file management tasks and edit metadata. Double-clicking on a video 
file in Keyword AI will launch the default video player for your computer.
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Extras
Photo Keyword AI’s Export function lets you export photos with both text and graphical watermarks (see 
“Export” on page 56). You can add your own watermarks — which are best suited as transparent PNG 
images — via the Export Manager.

To import a watermark, choose Manage Extras from the File menu and click on the Import button in the 
footer of the left column. A dialog box will appear where you can select the files to import. If you want to 
import an entire folder, open the folder, select the first file, then shift-click on the last file. Click Import 
when your selection is complete. Once your images have been imported, you will be prompted to save 
them in either an existing category (if there is one) or you can create a new one.

You remove imported watermarks using the Extras Manager. To delete an entire category, select in the left 
column and click on the Delete button in the footer of the left column. To delete individual watermarks, 
select them in the right column and click on the Delete button in the footer of the right column. Deleting 
extras is permanent and cannot be undone.

More information on using graphics-based watermarks can be found page 61.
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Customizing Keyword AI’s Keyboard Shortcuts
You can customize ON1 Photo Keyword AI’s hotkeys via the 
Keyboard Shortcuts window. This window lets you view and 
change the shortcuts for any tool, tool option, module, or menu 
item inside Keyword AI. You can assign shortcuts to menu items 
that don’t yet have a shortcut, build multiple sets of shortcuts as 
preset styles, and create a summary of your shortcuts that can be 
viewed in any web browser.

To view or change Keyword AI’s hotkeys, choose Keyboard 
Shortcuts from the Edit menu in any module. By default, Keyword 
AI’s shortcuts will be displayed, organized hierarchically by the 
following groups: 

• Modules (not applicable in Keyword AI).

• Tools, for the Zoom tool.  

• Menu, which includes all of Keyword AI’s menu items. 

You open each group by clicking on the triangle to the left of 
the group name, or you can use the search field at the top of the 
Keyboard Shortcuts window to search for a command in any of 
the groups (right). 

Each command that has an assigned key will display that key 
in the Shortcut column. The Shortcut field will be empty for 
any command that doesn’t have an assigned key, and any field 
with a grayed-out shortcut means that you cannot modify that 
command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste). In addition, the 
Escape, Return/Enter, and Delete keys can’t be used as a shortcut.

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be 
modified, but you can create your own set of 
shortcuts by double-clicking on any command 
you wish to add or change. You’ll be asked if you 
want to create a new preset. Clicking Yes will let 
you name the new preset style, and Keyword AI  
will make a duplicate of the Default set.

At this point, you can change any existing hotkeys, or add your own to commands that don’t have them, by 
double-clicking in the Shortcut field for that command. The field will be highlighted, and you can press the 

The Keyboard Shortcuts window displays a list of 
modifiable commands and operations in five distinct 
groups.

When you add or change a hotkey the first time, Keyword AI will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Keyword AI’s Default 
set—by using the pop-up menu at the top of the Keyboard Shortcuts window.
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key or key combination you wish to use. If that key is used by another command, a dialog will inform you of 
that, and giving you the option of either keeping the existing hotkey/command combination, or changing it 
to the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut 
field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original Keyword AI shortcuts by clicking on the pop-up menu at the top of the 
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be 
used to create a new preset or to delete an existing one that you created. The Default preset cannot be 
removed, however.

Changing Keyword AI’s font size
By default, Keyword AI prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Keyword AI’s Preferences window. Select 
the option from the Font Size pop-up, and restart Keyword AI to have the effect take place.

If you try to add a shortcut key combination that is already in use, Keyword AI 
will let you know, and give you the option of keeping (Cancel) or removing (OK) 
the other command/shortcut.

Keyword AI has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to the General tab 
of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you launch the app.
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PART 2: 
WORKING IN 

ON1 PHOTO KEYWORD AI
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Photo Keyword AI Main Screen Overview

Keyword AI has three sections: the Catalogs/Browse panel on the left side of the screen, the Preview 
window in the center, and the Photo Info panel on the right side.

The main components of Photo Keyword AI include:

A.	Shortcuts: This palette contains shortcuts to the Getting Started, Smart Organize and 
Advanced Search windows, as well as to your most common photo storage locations. (See 
“Using Shortcuts” on page 20.)

B.	 Preferences/Help/Panel icons: Accesses the ON1 Learning Hub or Keyword AI’s Preferences 
window. The icon at the bottom opens and closes the left panel.

C.	 My Catalogs/Browse Panels: Switch between the cataloged folders panel or browse local 
drives and cloud sources.

D.	Cataloged Folders: Displays your cataloged folders (shown) or local disks, favorite folders and 
cloud sources, depending upon which tab has been selected.

E.	 Albums Pane: This pane is for creating albums, or manually created collections of images. 
Albums can be grouped into subfolders for easy organization.

F.	 Smart Albums Pane: This pane includes collections of dynamically built albums based on 
criteria set in the Search bar.

G.	Dates Pane: Search for photos based on the capture date. 
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H.	View Selector: (Icons from left) Open/close the left panel; switch between Grid, Detail, 
Filmstrip, Compare and Map views.

I.	 Breadcrumbs: Displays the current folder hierarchy, or currently viewed album or smart 
album.

J.	 Search Bar: Lets you filter photos based on a wide array of criteria, including keywords, EXIF 
and IPTC metadata, ratings, camera type and more.

K.	 Preview: View your images in thumbnail or detail view. 

L.	 Thumbnail Size: Adjusts the thumbnail size in grid view.

M.	Sort Options/Smart Album/Smart Organize: The Sort pop-up adjusts sort order based on 
standard selection criteria; Smart Album saves the current search criteria as a smart album 
(cataloged folders only); clicking the last icon opens the Smart Organize window for finding 
duplicate and similar photos.

N.	Selection Information/Copy to My Catalogs: Lists the number of selected images out of the 
total number in the current view; Copy to My Catalogs lets you add the currently selected 
photos to any of your existing cataloged folders.

O.	Info/Navigator/Levels Panes: The Info pane displays detailed metadata about your image; 
Navigator displays a thumbnail view of your photo, regardless of zoom level; Levels displays 
RGB histogram data for the current photo.

P.	 Metadata Pane: This pane will show your metadata for the selected image. The top portion 
displays author and description information.

Q.	Keywords: Displays embedded keywords (both manual and AI-generated, if added).

R.	 AI Keywords List: Displays a list of suggested AI-generated keywords for the photo.

S.	 Album and EXIF/IPTC/Location Info: Includes the names of any albums in which the 
currently selected photo resides (does not include smart albums); Bottom tabs display 
additional EXIF, IPTC or location metadata about the selected file, if available.

T.	 Keyword List: Alphabetical list of all keywords found by Keyword AI, including both manually 
generated and AI keywords.

U.	Progress Indicator: Displays the progress of the current background processes, including 
keyword generation and embedding.

V.	 Export/Print: Shortcuts for exporting and printing selected photos. The bottom icon opens 
and closes the right panel.
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Getting Started with Keywording
ON1 Photo Keyword AI provides a great deal of flexibility in how you wish to work with your photos. You 
can browse for existing photos in folders that are connected to your computer (including cloud services like 
Dropbox, Google Drive and Microsoft OneDrive). You can also import photos directly from your camera or 
other device (see “Importing Photos into Keyword AI” on page 38). 

If you store your photo library in a specific location on an internal or external hard drive (or multiple drives), 
you can have Keyword AI index those folders. This process ‘catalogs’ the photos, reading their metadata 
and building previews, letting you navigate and access your photo library much more quickly than if you 
were to simply look at a random folder of images. Cataloging a folder doesn’t move or change your photos; 
it just makes it easier for you to find and work with them inside Keyword AI. (Information on cataloged 
folders and how they work starts on page 17.)

THE GETTING STARTED WINDOW

The first time you launch Keyword AI, the Getting Started window is displayed, designed to help you get 
working quickly. This window has two options:

• Catalog & Keyword Your Photos: clicking this button will let you choose a folder to be 
cataloged by Keyword AI. This folder (and any subfolders of photos within it) will be added 
to the My Catalogs pane, and Keyword AI will automatically scan those folders and generate 
AI-based keywords. (See “Cataloged Folders” on page 17 for info on creating cataloged 
folders.)

• Browse a Folder: this button will open the file-selection dialog for your computer. There, you 
can navigate to a specific folder of photos. Clicking the Open button in that dialog will display 
that folder’s photos in the Preview area. To scan for AI-generated keywords, you have to 
manually process each folder. 

The Getting Started window can be accessed at any time via the Help menu, or by clicking the ‘+’ button in 
the Shortcuts section on the left side of the Keyword AI window (see “Using Shortcuts” on page 20). 

The Getting Started window is designed to help you get working quickly with ON1 Photo Keyword AI.
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BASIC KEYWORD AI PROCESS

When using Photo Keyword AI to keyword your photos, the basic process is as follows:

1.	 Scan a folder of images, either automatically (cataloged folders) or manually.

2.	 Add any manual keywords, if desired.

3.	 Perform any additional metadata operations (ratings, color labels, etc.) and culling.

4.	 Embed metadata into the files, directly or as XMP sidecar files (depending upon the file 
format).

5.	 Import the keyworded photos into your photo editing app, or update the metadata for those 
photos if they’re already cataloged there.

By default, when Photo Keyword AI scans a photo, the AI keywords are automatically written to the 
Keywords section of the Metadata pane and embedded into the original files or sidecars. See page 15 
for methods that adjust the automated processes inside Keyword AI. 

NOTE: ON1 Photo Keyword AI performs nearly all of its Keyword AI scanning 
entirely on your computer. (The exception is for reverse lookup of GPS 
coordinates.) At no point are your photos uploaded to the cloud or shared.

CREATING AI-GENERATED KEYWORDS

The AI-generated keyword feature is located in the 
Metadata pane on the right side of the main window, at 
the bottom of the Keywords section.

When you add a cataloged folder, Photo Keyword AI will 
automatically scan all the photos in that folder (and its 
subfolders), and, in the background, will generate a list 
of AI-based keywords for each photo. When you select a 
cataloged photo in the main window, those AI-generated 
keywords will be visible the AI Keywords section of the 
Metadata pane (see page 24 for complete specifics on 
the Metadata pane).

With non-cataloged folders, you must manually scan 
your photos to generate AI keywords. To generate a group of keywords, select a photo, and click the Scan 
button in the AI Keywords section or right-click on the photo and choose Scan from the pop-up menu. To 
generate keywords for a folder of photos, select all the photos and click the Scan button (or use the pop-up 
menu). 

Depending upon the number of photos you’re scanning — either with cataloged folders or groups of non-
cataloged folders — it can take some time for all of the photos to be scanned. A progress indicator will be 
visible at the bottom right side of the main Photo Keyword AI 
window. Hovering your mouse over the indicator will display a 
tool tip of the current job; clicking on the ‘x’ will cancel the job.

The AI Keywords section of the Metadata pane is where AI-
generated keywords are displayed. For cataloged folders, Keyword 
AI will automatically populate the AI Keywords section; For 
non-cataloged folders, click the Scan button to generate keywords.



ON1 Photo Keyword AI User Guide	 Part 2: Working in Keyword AI	 15

KEYWORD AI’S DEFAULT SETTINGS AND HOW TO CHANGE THEM

When you install Keyword AI, the default settings are such 
that for any scanned photo — regardless of whether it is in a 
cataloged folder or not — the app will automatically add the 
complete group of AI keywords to the Keyword section of the 
Metadata pane. This is determined by the “Write Keyword 
AI Results to XMP” tab in the Preferences settings (see page 
84). This option is on by default.

To change this process from an automatic to a manual 
operation, follow these steps:

• Turn off the Preferences’ “Write Keyword AI Results 
to XMP” setting and restart Photo Keyword AI. 

• To add AI-generated keywords, click on the up 
arrow label on the keywords you wish to add to the 
Keywords section. 

• If you want to add the bulk of the AI-generated  
keywords, but there are a few that you don’t wish 
to have in the embedded XMP data, hover over the 
right side of the AI keyword and click the ‘x’ label for 
each keyword you wish to remove. Then click Add All.

NOTE: Turning off the “Write Keyword AI Results to XMP” setting will only 
affect AI keyword scanning from that point forward. The metadata for any 
previously scanned photos or folders — including the addition of AI keywords — 
will remain intact.

Adjusting Keyword AI’s default scanning settings

You have a few options for fine-tuning the 
specifics of what Keyword AI searches for 
when creating AI-generated keyword; these 
options can be found in the Keyword AI tab 
of the Preferences window. There, you can 
choose what type of data you want to include 
when Keyword AI is scanning your cataloged 
folders. These options include location data, 
photographic properties, histogram properties, 
face, age and gender information, and specific 
objects and regions. If, for some reason you do 
not want the Keyword AI feature to scan your 
cataloged folders, you can also turn the feature 
off from the Preferences window.

By default, when a photo is scanned (regardless of its 
catalog status), Keyword AI will automatically copy all of 
the AI-generated keywords to the Metadata pane’s 
Keywords section. 
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EMBEDDING METADATA

When you create keywords (AI-generated or manually entered) and other metadata (ratings, labels, 
descriptions) for photos, this information needs to be embedded with the photo so that it is visible when 
viewed in other applications, like Adobe Lightroom, Photoshop or Capture One. Depending on the file type, 
this metadata information can be put in the file itself, or it can be included as a separate file, called a 
sidecar, that sits with the associated photo in its folder. These sidecars have an .XMP file extension — for 
Extensible Metadata Platform — and are readable by most photo apps.

By default, Photo Keyword AI embeds metadata automatically as you’re working; to change this, uncheck 
the Automatically Embed Metadata item in the 
Photo menu. 

To embed metadata manually from that point on, 
select a photo or group of photos, and choose 
Embed Metadata from the Photo menu. You’ll 
be asked to verify that you wish to embed the 
metadata for the photo or group.

READING METADATA INTO OTHER APPS FROM KEYWORD AI

Most of the popular photo editing and organizational apps have a 
mechanism for reading and writing metadata to files. When importing 
photos tagged with Keyword AI into Lightroom or Capture One, for 
example, those apps will recognize keywords (and other metadata) you 
have added in Photo Keyword AI and save them within their catalog 
structure. 

If you want to use Keyword AI on photos that have been cataloged by 
other apps, open the folder containing those photos. You should see any 
existing keywords or other compatible metadata, and you can scan and 
generate AI keywords and embed them back into the files. When you’re 
done and back in your originating editor, you will have to read the updated 
metadata back into that app. Lightroom has a flag that will indicate that 
the metadata for a photo has been changed; you can click on that photo 
(or all photos with that flag) and choose Read Metadata from File from the 
Metadata menu. Capture One has a similar command, available from the 
Image menu, but it doesn’t have an easy way to determine if the metadata 
has changed.

Lightroom displays a badge (upper right) 
indicating that the metadata file on disk 
has changed, You can easily select these 
files and read the updated metadata 
with a menu command.
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My Catalogs and Browse Panels
On the left side of the Browse window are two tabs, My Catalogs and Browse, each of which is designed 
to let you organize and find your photos quickly and easily. To move between the panels, click on the 
appropriate tab at the top of the panel. You can hide the left panel by clicking on the Show/Hide Panel 
icons at the bottom left and right sides of the panel. (Pressing the Tab key will show and hide both panels 
simultaneously.)

DIFFERENCES BETWEEN MY CATALOGS AND BROWSE TABS

The top panes in the My Catalogs and 
Browse panels contain different views of 
your folders and other sources, most of 
which are designed to help you with file-
related tasks. 

The My Catalogs pane lists all of your 
cataloged folders, as well as the Albums, 
Smart Albums, and Dates panes. 

The Browse panel includes a Favorites pane, 
which lets you add and access frequently 
visited folders; it also includes a configurable 
list of cloud storage services. The remainder 
of the panel includes Local Drives and 
Albums panes.

Navigating Sources

To view the contents of any folder in the 
Cataloged Folders or Local Drives panes, 
click on the triangle next to the folder name. 
This will display the photos and subfolders 
within the selected folder inside the Preview area. To view the contents of a subfolder, either click on the 
subfolder inside the Folders pane, or double-click on it in the Preview area. (You can use the breadcrumbs 
bar at the top of the Preview area to navigate back to the top of your folder system.)

TIP: Any pane in Keyword AI can be collapsed by clicking in the pane’s title bar; 
a Hide/Show link is visible when you move your cursor over the title bar, but 
the entire title bar is clickable. 

CATALOGED FOLDERS

A cataloged folder is a shortcut for your favorite or most-used folders of photos. A folder designated as 
cataloged is cached in the background to improve the speed of loading those folders (and any subfolders) 
and their photos. Cataloged folders are ideal for portfolios, your favorite photos, or for your primary library 

The My Catalogs view (left) displays your cataloged folders, albums, smart albums 
and has a date view. The Browse view (right) displays Favorites (for quick access), 
cloud storage services you have installed,, local storage, and albums.
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of photos. Cataloged folders are necessary when using the Advanced Search feature to search for photos 
across multiple folders.

You can make any available folder a cataloged folder by clicking on the ‘+’ button at the top of the 
Cataloged Folders pane; by right-clicking on a folder in the Preview area of the Browse panel and choosing 
Make Cataloged Folder from the pop-up menu; or by choosing Add Cataloged Folder from the File menu. 
The cataloging process is designed to work in the background, so it doesn’t affect other work you do in any 
Keyword AI module. (You’ll see a small progress indicator to the right of the folder as this process happens.)  

When you catalog a folder, you will be prompted to choose the size of the previews that are generated 
during the cataloging process. The three thumbnail options are:

• Standard, which extracts the image metadata and EXIF thumbnail and creates a high-quality 
thumbnail and a fit-screen-sized preview.

• Medium, which extracts metadata, EXIF thumbnail and creates a high-quality thumbnail.

• Minimal, which extracts metadata and the EXIF thumbnail only.

For most purposes, you’ll want to choose the default preview size, Standard. If, however, you are working 
with a system that has disk space restrictions, or have a network connection to your cataloged folder, 
choose either Medium or Minimal. (You can change the 
preview size later by right-clicking on the folder in the My 
Catalogs list and selecting the Preview Size option.)

To remove a cataloged folder, right-click on the folder in the 
pane and choose Remove Cataloged Folder.

Adding photos to existing cataloged folders

You can add photos from any location inside Browse to 
an existing cataloged folder via the Copy to My Catalogs 
option. To use this feature, you must already have at least 
one cataloged folder. Then, when working in Browse, select 
the photo or photos you wish to add, and choose Copy to 
My Catalogs from the File menu, or via the folder icon (with 
a ‘+’ button) to the right of the search bar at the top of the 
Browse window. (You can also right-click on a photo and 
choose Copy to My Catalogs from the pop-up menu.)

The Copy to My Catalogs dialog box lets you copy or move 
selected photos into your existing cataloged folders.
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Inside the Copy to My Catalogs dialog box, you can choose which cataloged folder you wish to copy the 
photos, can add them to a new subfolder, and choose whether to move the photos or copy them. 

Moving the files is only available when you are moving the photos to a new location on the same drive; 
otherwise, a copy of the file is made in the new location.

FAVORITES

Keyword AI’s cataloged folder feature is useful for 
keeping your primary photo library organized, but there 
might be times when you have a group of folders that 
you frequently access, but that you do not wish to have 
cataloged. (One common instance might be a folder where 
you export temporary images for social media or other 
uses.) In these cases, the Favorite folders option can be 
helpful. Any folder you designate as a favorite will appear 
in this area, along with cloud-based storage services like 
Google Drive, Dropbox and OneDrive.

To add a folder, click the ‘+’ button in the Favorites pane. 
You’ll get your system’s file/folder selection window. Navigate to the folder you wish to add, then click 
Open. Alternatively, you can navigate to your chosen folder in Browse and drag the folder onto the ‘+’ icon 
in the pane, or right-click on the folder and choose Add to Favorites from the pop-up menu.

Cloud storage services

Browse supports cloud storage services from Dropbox, Google Drive, and Microsoft OneDrive. These 
services—when installed on your computer and other devices—keep local copies of your images on your 
computer, and Browse can find and monitor these locations automatically. 

During the installation process, ON1 Photo Keyword AI automatically looks for the default installation 
locations for these services. If you do not have one of these services installed, and wish to remove it, right-
click on the service name in the Favorites pane and choose Remove from Favorites from the pop-up menu. 
If you add one of these services after installing Keyword AI, click the ‘+’ button at the top of the pane, and 
locate the folder via your computer’s file-selection window. 

LOCAL DRIVES

Browse automatically recognizes any disk (volume) inside 
or attached to your computer. This includes internal and 
external hard drives, optical drives, thumb drives, digital 
camera memory cards, digital cameras, any devices that 
support USB Mass Storage, and network-attached services 
(including mapped volumes on Windows).

Disks appear in the Local Drives pane below the Favorites 
section, with a hard drive icon next to them. Keep in mind 
that some disks, like optical drives, are often read-only. 
You will be able to view a copy of a photo, but will be 
prompted to save the image to a new location if you wish 
to edit it.

The Browse panel’s Favorites pane lets you add frequently 
accessed folders that might be used for temporary or other 
applications.
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USING SHORTCUTS

The Shortcuts selector on the left side of the Browse panel is 
a list of icons designed to give you quick access to a number of 
commonly used system destinations or Browse functions. From 
top to bottom, the icons represent the Getting Started window, 
your Desktop, your Pictures folder, cataloged folders, local drives, 
and albums. Clicking on one of the icons will either display the 
shortcut’s contents in the Preview window (Desktop, Pictures, 
Cataloged Folders, Local Drives or Albums), or will open  the 
Getting Started screen.

By default, the Pictures shortcut uses your My Pictures folder 
(Windows) or Pictures (Mac). You can change the default location 
in the General section of the Preferences window (see “General 
Settings” on page 82).

Shortcuts can be useful when you have the right panel hidden to maximize viewing in the Preview window.

ALBUMS PANE

ON1 Photo Keyword AI’s Albums feature lets you organize or keep 
track of photos on a project, event or even a broader category like 
a portfolio. Albums are created by selecting images manually and 
adding them to a new (or existing album) by dragging and dropping 
photos onto the pane. You can nest albums together to help 
manage your collections.

Creating an album

Click the ‘+’ icon in the pane and choose Create Album… from the 
pop-up menu. You can also create an album by selecting photos and 
dragging them onto the ‘+’ icon in the Albums pane.

The New Album dialog box gives you options for adding an album 
name, and whether you wish to add the selected photos to the new 
album. 

Adding photos to an existing album

There are multiple ways to add photos:

• Dragging and dropping a photo on the 
album name.

• Selecting a photo or group of photos, 
right-clicking on the photo and 
choosing Add to Album from the pop-
up menu.

• Choosing Album > Add to Album and 
picking the destination album from the menu.
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• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Removing photos from an album

To remove a photo (or photos) from an album, select them in the album, then choose Remove from Album 
from the Album menu, or right-click on the photo and choose Remove from Album from the pop-up menu. 
(You can also select a photo and press Shift-Delete.)

Delete an album

To delete an album, right-click on the album name and choose Delete.

Changing the album thumbnail preview

To change the preview thumbnail of an album, double-click on the album name. Select a photo you would 
like to use for the preview, right-click on it and choose Set Album Preview from the pop-up menu.

Nesting albums

To create a set of nested albums, create a blank album by clicking on the + icon in the Albums pane. You can 
easily add sub-albums to that new master album set by dragging and dropping albums onto the new one in 
the Albums pane. When you click on the master album, Browse will display the albums that are part of that 
collection in a folder-style view. Double-clicking on an album icon will display the contents of that album. 
To view all the images in a nested set, choose Show Subfolder Contents from the View menu.

To move a sub-album from a master album to the top Albums level, drag and drop it out of the master, or 
right-click on the sub-album name and choose Move to Top.

When you click on a nested album set, Browse displays the sub-albums. Double-clicking on a sub-album will open that album. If you wish to 
view all of the images in a nested album set, click the Show Subfolder Contents button from the View menu.
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If you drag an album onto an existing album that already contains images, you will see the top-level album’s 
images at the root level, along with any sub-albums.

SMART ALBUMS

Smart albums are a dynamic album type that created from 
the results of a custom search operation built within the 
Advanced Search toolbar (see “Finding and Filtering Images 
with Advanced Search” on page 42). When you use 
Advanced Search to create a filtered set of photos in your 
collection, such as “all photos that have been rated three 
stars or greater after June 2018,” you can save that search 
as a smart album, and, when you click on the album, Keyword AI will perform that search in real time.

You can edit, rename or delete smart albums by right-clicking on the album name. The Edit option reopens a 
version of the Search bar, letting you change the criteria for that smart album.

DATES PANE

Keyword AI’s Dates pane offers a quick way to look for 
cataloged images based on when they were taken. Using a 
simple timeline interface, you can drill down into your photo 
library by year, month and day. It makes searching for things 
like birthday and holiday photos a snap.

Opening the Dates pane, you’ll see a list of years, with the 
current year at the top (only years that have photos taken 
during them will be present in the list). Clicking on a year will 
show you all of the photos taken during that year. Clicking 
on the triangle to the left of the year will display a list of all 
the months that have photos in them, and you can keep drilling down to the day level. Drilling down to any 
level in the pane—year, month, day—will show all photos taken during that period.

The Photo Panel
The panel on the right side of the screen contains information relative to the currently selected image in 
the Preview area, and includes three sections: Nav, Levels, and Info.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane presents a thumbnail view of the current image. 
The white square region marks the image area that is visible 
in the preview pane. You can pan your image by clicking and 
dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views. Click on one 
of the buttons to change the view. Fit zooms to fit the photo, 
100 zooms to 100%, displaying the actual pixels.
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THE LEVELS PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane gives you a color chart of the shadow, midtone 
and highlight areas based on an image’s RGB values 
(commonly known as a histogram). This is useful to show 
areas within the image that may be clipping. Clipping is when 
your image contains pure blacks or white and can signify loss 
of highlight or shadow detail.

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is 
a triangle. If the triangle is lit, there is clipping on that side of the histogram. If you click on the arrows, you 
will activate the clipping overlay on your image, which displays the areas that are clipped. Those areas with 
a blue overlay are pure black, while the areas with the red overlay are pure white. You can turn the clipping 
view off again by clicking on one of the triangles. You can also temporarily enable clipping view by holding 
down the J key at any time. (Clipping can be turned on or off permanently by pressing Alt (Windows) or 
Option (Mac) and the J key.) The clipping view is useful when you are making adjustments to the brightness 
and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

INFO PANE (ALL VIEWS)

The Info pane displays common metadata and other 
information for the currently selected image in a large, 
easy-to-read format. This metadata includes:

• Camera make and model

• Lens focal length

• Capture date and time

• File type

• ISO

• Shutter speed

• Aperture

• Exposure compensation

• Image dimensions

• File size

• Rating, color label and like status

• Any settings applied inside the Edit module

If any of the metadata fields are unavailable they will be left blank.
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METADATA PANE

The Metadata pane displays all of the available metadata 
information about a photo in one place. Some of this is 
embedded metadata from your camera, while other elements 
can be added manually, or you can have Keyword AI 2023 scan 
your photos and suggest keywords based on their contents, 
making it easy to find photos based on a wide variety of data 
types.

The Metadata pane consists of the following sections:

A.	Preset: Lets you apply a saved metadata preset (see 
page 25) to your image, which can include any 
changeable metadata found throughout the pane.

B.	 Author and Description: For manually entering 
author information and a description. (The Author 
field is tied to the IPTC Creator field.)

C.	 Keyword section: Add keywords manually and 
modify existing keywords.

D.	AI Keywords: Automatically generated keywords 
based on image data and AI semantics (see ).

E.	 Albums: Lists all albums that the current photo 
resides in.

F.	 Show EXIF/IPTC/Location data: When clicked, 
each tab displays specific information on the current 
photo, much of which can be edited or changed (see 
page 24)

Other metadata

The bottom of the Metadata pane has three labels/tabs for 
viewing or adding specific types of information to your photos:

• EXIF (Exchangeable Image File Format) displays all 
of the data embedded by your camera. Depending 
upon the camera, some of all of this information will 
be displayed, and many of the fields are editable. 

• IPTC (International Press Telecommunications 
Council) is an industry-standard metadata format, 
and offers much more detailed metadata information 
than EXIF. It historically has been used by journalists and stock photographers to catalog and 
tag photos, as well as add copyright information, captions, and other data.

• Location includes GPS information, as well as country, state/province and city information. 
Keyword AI can automatically look up this information for any photo that has GPS 
coordinates, via the Set Location from GPS Coordinates item in the Photo menu.
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To go back and forth between the EXIF, IPTC and Location fields in the Metadata pane, click on the label. If 
you don’t wish to view any of the metadata tabs, click the None tab. 

When you enter text into any field in the Metadata pane, Keyword AI will add that information to the 
currently selected image. You can change the metadata in multiple images at the same time by selecting 
them all, then changing any of the fields in the pane.

Metadata templates

With Keyword AI, you can create metadata templates that apply common information to your images, such 
as copyright, author, contact information, your website and more. These preset templates can be applied 
directly in the Metadata pane, as well as via the Import feature (see “Importing Photos into Keyword AI” on 
page 38).

Saving a metadata template is easy: you can either go to an 
image that has the basic metadata items you wish to use, 
or you can select an image without metadata and add your 
common items to the Metadata pane. Once you have the 
metadata set, click on the Preset drop-down menu at the top 
of the pane and choose Save New Preset. The Save Preset 
dialog will appear on-screen, and you can choose which 
metadata fields you wish to save as part of the template. 
For example, while you might wish to save the copyright and 
contact information as part of your preset, you might not 
want to apply keyword, GPS or description data to a group 
of images. 

You can update a metadata template by selecting the preset 
in the pane, then changing the appropriate fields as desired, 
and then choosing Update Preset with Current Settings from 
the Preset drop-down. To delete a metadata preset, first 
choose the preset from the drop-down menu, then choose Delete Preset from the menu. 

Embedding metadata

Metadata that you add in Keyword AI is stored in industry-standard XMP sidecar files for raw files. This 
facilitates the transfer of metadata to any application that supports XMP. When you edit an image, create 
a copy of an image for editing or use the ‘Send to’ command, the metadata is embedded into the file 
automatically (with the exception of raw files). You can manually embed your metadata into images using 
the Embed Metadata command from the Photos menu. This will open each image you have selected, 
update the metadata and re-save it. This is supported for TIF, PSD, PSB and JPG files; raw and PNG files do 
not support direct embedding of metadata.

Reading metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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KEYWORD LIST PANE

As you add cataloged folders or browse through folders 
of non-cataloged photos inside ON1 Photo Keyword 
AI, any keywords you have added—to any photo—are 
stored in an internal database. That list of keywords 
is visible in the Keyword List pane, and from there, 
you can search for established keywords and display 
those photos from your cataloged folders, manage the 
keyword list, and apply keywords to new images. And, 
to help manage your keywords, Keyword AI 2023 will 
also let you create subcategories of keywords (see 
“Using hierarchical keywords with Keyword AI” on page 
26).

If you double-click on a keyword in the list, Keyword AI 
will search your cataloged folders for that keyword, and display the results in the Preview window. In this 
search, Keyword AI is actually performing a search in the Advanced Search pane, so you can refine your 
search there, if you wish to add additional filter criteria. (If you would like to search the current folder only, 
choose the Filter Current Photos option in the Advanced Search pane.)

You can assign keywords to an image in any of Keyword AI’s views. Click on the button to the left of a 
keyword in the Keyword List, and Keyword AI will apply that keyword to the currently selected image or 
images. (You can also enter keywords into the Add Keywords field in the Metadata pane.)

Right-clicking on a keyword gives you a pop-up menu with a list of options you can perform:

• Assign Keyword to Selected Photos: adds that keyword to the current selection.

• Remove Keyword from Selected Photos: removes that keyword from the selection

• Add Keyword: Lets you create a new keyword, with the option to save that keyword as a 
subcategory of the currently selected keyword.

• Edit Keyword: lets you rename the selected keyword, and applies the new keyword to all of 
the cataloged and known photos that used it.

• Delete Keyword: Removes that keyword from the cataloged and known photos that use it.

• Find Cataloged Photos with Keyword: Displays (in grid view) all of the photos in your 
cataloged folders that use the selected keyword.

Refining the Keyword List

Because the list of keywords can be extremely long, you can use the pane’s search field to look for 
keywords: as you start to type in the field, Keyword AI will display a list of keywords that contain the 
letters you’ve typed. Once you’ve narrowed your search, you can select a keyword from the list (shown, 
right), and perform any keyword operations detailed in the previous section.

Using hierarchical keywords with Keyword AI

In addition to standard keywords, ON1 Photo Keyword AI also supports the creation and use of hierarchical 
keywords. This option lets you “nest” keywords within a top-level keyword, which can be helpful to manage 
and categorize keywords. 

The Keyword List includes any keywords you’ve ever used, but you 
can filter the list by typing into the search field at the top of the 
pane. Double-clicking on an item in the pane will display all of the 
photos that have that keyword.
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For example, you might want to use a master keyword for states that you’ve visited—“California,” “Nevada,” 
“Oregon,” etc.—and use sub-keywords for places within the state, like “Death Valley,” “Joshua Tree”, “Valley 
of Fire” and others. 

Hierarchical keywords are displayed in the Keyword pane 
with a small right arrow to the left of the top-level keyword. 
Clicking on the arrow will display the sub-keywords for that 
master, with the number of images with that keyword on the 
right side. As is the case with standard (i.e. non-hierarchical) 
keywords, you can double-click on any of the nested 
keywords to show all of the photos in your cataloged folders 
that use that keyword.

To create a keyword hierarchy, first create your master 
keyword by clicking on the gear icon at the top of the 
Keyword List pane and choosing Add Keyword. Enter the 
name of the top-level keyword and click Apply. (If you have 
photos selected, and don’t want to add the new keyword 
to those images, uncheck the “Add to Selected” box before 
clicking Apply.)

To create a new nested keyword, right-click on the master keyword and choose Add Keyword from the 
pop-up. The dialog box should now give you a check box to nest the new keyword inside the top-level 
keyword, as well as to add the new keyword to any selected photos.

If you wish to create new hierarchies from existing keywords, it is best to first create your master keyword, 
and then drag any existing keywords onto that master. 

Working in the Preview Area
The Preview window is the largest part of the Keyword AI workspace. Here, you can view folders of images 
in either thumbnail or detail view, based on the folders, albums or filters you have chosen via the Browse 
panel. There are five main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. This view also displays folders, 
letting you go up and down a folder hierarchy quickly. You can also change the information 
displayed in each cell in the grid. Shortcut key: G

• Photo (also known as Detail), which you get by double-clicking on a thumbnail. You can view 
this image in either ‘fit to window’ view, or can zoom in to see more detail. Shortcut key: E

• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 

Hierarchical keywords can help with keyword management, 
and can be extremely useful when you wish to use primary 
and secondary categories for such image categories as 
locations, people, types of shoots, and so on.

To create a hierarchical keyword set, create the top-level keyword by choosing Add Keyword from the Keyword List pop-up. Then, right-click the 
top-level keyword and choose Add Keyword. There, you will have the option to nest the new keyword inside the top-level keyword. 
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The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area. 
Similar to Detail view, the Filmstrip mode lets you view the current image in ‘fit to window’ 
and zoom views. Shortcut key: F

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more. 
Shortcut key: C

• Map, which can be used to display locations for photos that have GPS-based location data, or 
to search for locations that can then be applied to a photo or group of photos. Shortcut key: M

You can change the viewing mode between the different views by clicking on the view selector at the 
bottom of the window, or by using the shortcut keys listed above. 

USING KEYWORD AI  WITH A SCROLL WHEEL

When you are using Keyword AI with a mouse that has a scroll wheel, there are two navigation options 
available, on both Mac and Windows:

• Using the scroll wheel will pan up and down in the current window. In Thumbnail view, it 
will scroll the window. In most other views, using the scroll wheel with the cursor over the 
preview area will pan the image on screen up and down. Holding the Shift key down and 
scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

ALTERNATIVE VIEW MODES

In all of Keyword AI’s preview modes you have three options for viewing the contents of the current 
window:

• Keyword AI’s default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view 
a selection of photos as large as possible without any distractions. (This mode can also be 
turned on by pressing Shift-F (MacOS only).)

Using Keyword AI to display slideshows

You can create on-the-fly, full-screen slideshows to display groups 
of photos inside Browse. Select a group of photos in the preview 
area, and choose Quick Slideshow from the Window menu. The 
slideshow will loop until you stop, by pressing the Esc key.
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The Quick Slideshow submenu has options for the amount of time between slides and whether to display a 
fade transitions between slides or have no transition at all. 

FAST PREVIEW MODE

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. Keyword AI’s Fast Preview mode lets you do just 
that. Select Fast from the View menu’s Preview Quality option, and you can jump from photo to photo 
quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the Preview 
Quality option in the View menu. ON1 Photo Keyword AI will generate a full-resolution preview of your 
photo, using the photo’s embedded color profile. This will take a few seconds, depending upon the size of 
the raw file you’re working with, but you will get a better sense of the actual color in the photo.

Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time you browse a folder. It also stores user-added 
or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, among others. You 
can adjust the size of the cache and the storage location of the cache in the System tab in Keyword AI’s 
Preferences window (see page 83).

FOCUS AND CLIPPING VIEWS

When you’re viewing photos with an eye toward selecting the best images in a group for editing, you 
generally want to look at issues with both exposure and sharpness. To help you with this, Keyword AI 
offers two viewing aids that are available in both the Browse and Edit modules: Clipping and Focus Mask 
overlays. In the Browse module, you can display these overlays in Detail, Filmstrip and Compare modes; in 
the Edit module, the overlays can be displayed in any of the tabs.

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, rather 
than fading smoothly. (Large expanses of white pixels in a photo 
are often referred as ‘blown’ highlights, and can be distracting.) 
One of the benefits of shooting in raw format is that, while 
many photos will have areas of pure white or black when 
originally viewed on-screen, there is still recoverable data in the 
raw image. The Clipping overlay can help determine how big a 
problem you might have with a photo, and how easy (or difficult) 
it will be to fix. 

To display the Clipping overlay temporarily, press the J key; to 
turn it on permanently, choose View > Show Clipping, or press 
Alt (Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays areas that have either pure white or pure black in them. Areas with a 
blue overlay indicate pure black pixels, while the areas with a red overlay indicate pure white pixels.

Clipping view displays pure white pixels with a bright 
red overlay, and pure black pixels with a bright blue 
overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Keyword AI’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt/Option J. The sharpest areas in your 
image will be represented by a bright green overlay. As you 
move from photo to photo in a folder, you’ll be able to tell 
whether you have an acceptable level of sharpness where 
you need it by the strength of the overlay. The mask will 
continue to be displayed even as you zoom in on a photo.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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WORKING IN GRID VIEW

Grid view displays thumbnails of folders and images you have selected using the Folder or Albums panes. 
There are many operations you can perform from inside Grid view, including:

• Use the breadcrumbs to navigate (the ‘<’ button goes up one folder).

• Select your image while in Grid view and open the photo in one of the editing tabs.

• Adjust thumbnail size using the on-screen slider or use “-/+” keys on your keyboard.

• Choose Show Subfolder Contents from the View menu when you want to view the contents 
of all subfolders (this only works when you are viewing cataloged folders).

Changing the thumbnail display options

You can change the display characteristics of each 
thumbnail cell in Grid view, via the Thumbnail View 
Options command, which is in Keyword AI’s View 
menu (and available when you right-click on any 
thumbnail in the grid). The Thumbnail View Options 
window has two sections, one for choosing the 
appearance of each thumbnail, the other for the 
information labels associated with each thumbnail.

In the Appearance section, the Size option sets 
the size of the top and bottom label text (Small or 
Large); the Fitting options let you set the image 
thumbnail so that all of the image is displayed 
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(Fit) or that it fills the frame of the thumbnail (Fill); and the Theme option lets you choose a Dark or Light 
appearance.

The Labels section lets you adjust the displayed data for the top (right and left sides) and the bottom 
labels in each thumbnail, and how each label is displayed—all the time, or only when you mouse over the 
thumbnail. You can also choose whether to display the rotation arrows and edit badges (which indicate that 
the image has been edited inside Keyword AI), as well as preview images for folders viewed inside Browse.

By default, the labels are set up to display the ratings and label information on the top left, the favorites 
state (like, empty, reject) on the top right, and the bottom displays the filename. You can however, set any 
of the three label locations to display any of more than 20 pieces of metadata, including filename, camera 
and lens information, exposure and ISO, capture date, ratings, image dimensions, and much more.

NOTE: Most of the data fields that you can display in the Thumbnail View 
Options are visible in the Metadata panel. See “Metadata Pane” on page 24 
for more information.

Sorting photos in Grid view

When working in Grid view, you can sort the thumbnails in a number of different ways by choosing the Sort 
By pop-up at the bottom of the window. The sorting options include: date captured or modified; color label; 
file name, type, or size; and rating. 

You can also create a custom sort order by dragging thumbnails inside the grid window; click and drag the 
thumbnail so that the outline sits between two images. 

Once you change the order of images this way, the 
Sort pop-up will change to Custom, and Keyword AI 
will remember the sort order for that folder until you 
change it. (Custom sorting also works—and the custom 
order remembered—when you’re viewing albums.)

At the bottom of the Sort pop-up are settings for 
sorting the view in ascending or descending order; 
selecting one of the options will rearrange the view 
accordingly. If you have a custom sort order, choosing 
these options will change the view in the opposite 
order.

Metadata viewing in Grid view

When you have the Photo panel open on the right side of the screen in Grid view, Keyword AI will display 
the Info pane at the top, which includes summary information about the selected photo, and the Metadata 
and Keyword panes, which let you view, edit and adjust many of the metadata fields for the current photo. 
When you have multiple items selected, the panes will display the information for the primary item in the 
selection (represented with a heavier outline in the grid); adding keywords or other editable metadata 
(author, location data or descriptions, for example) will apply those items to the entire selection. See page 
22 for more on the Photo panel and its operation.  

To reorder a photo in Grid view, drag it between the two photos 
where you want it to be placed.
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WORKING IN PHOTO (DETAIL) VIEW

In Photo view—also known as Detail view—you get a full-screen version of your photo. When you go to 
this view, your images will be displayed in Fit mode, showing the entire image. You can click on the image 
to zoom in to 100%. This is useful for judging small details and sharpness. Single-clicking on a image that is 
magnified will return back to Fit mode. You can click and drag a magnified image to look around. Your zoom 
mode is maintained as you move from image to image so you can compare the same spot in several frames.

When you view an image in Photo view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 22 for details on the Nav, Levels and Info panes.)

When working in Photo view, you can move to the next image by using the arrow keys on your keyboard, 
and you can add author, keyword, description and other information via the Metadata and Keyword List 
panes.
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WORKING IN FILMSTRIP VIEW

Filmstrip view presents a large version of your current image in the preview area, displaying other photos 
from the current view in a strip of thumbnails at the bottom of the screen. The photos are sorted by the 
current sort order, which can be changed via the Sort pop-up above the strip.

The current image is represented by a blue rectangle in the filmstrip, and you can use the arrow keys to 
move from photo to photo, or you can scroll with your mouse and click on a photo to display it in the 
preview. (You can also rate and flag images inside this view.)

When you view an image in Filmstrip view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 22 for details on the Nav, Levels and Info panes.)

Filmstrip view is similar to Detail view, but displays a strip of photos from the current folder (or album). You can easily move to another photo by using the 
right and left arrow keys, or by scrolling and clicking with your mouse.
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WORKING IN COMPARE VIEW

Compare mode is for those times when you shoot a sequence of photos of the same type of scene—a 
portrait session, a wedding, a landscape series, for example—and wish to narrow that group down to 
find your best ones. With Compare, you can select a group of photos, view them side-by-side to check 
composition, zoom in simultaneously to check focus, and rate your favorites and remove the rejects.

To use Compare mode, you can choose one of two methods:

• Select a group of images you wish to compare in either Grid or Filmstrip view. To select a 
group of contiguous photos (ones next to each other in order), simply click on the first one 
you wish to compare, then hold down the Shift key and click on the last photo. If you want to 
add noncontiguous photos, click on the first photo, then use the Command (Mac) or Control 
(Windows) key and click on each subsequent photo you wish to compare. When you have 
your selected photos, press the C key, or click on the Compare icon in the View Selector at 
the bottom left of the Browse window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 
selection will have a light gray box around them. You can switch the primary selection by using the arrow 

Compare mode displays selected photos as panes inside the preview area. The photo highlighted with a blue box is the current selection. Clicking in that pane 
will zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all of the compared photos will zoom with it.



ON1 Photo Keyword AI User Guide	 Part 2: Working in Keyword AI	 36

keys on your keyboard, or by clicking inside the pane you wish to make primary. 

If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Use the spacebar if at you want to zoom between fit and 100% on the selected photo in the grid. Toggling 
the spacebar between views does not “lock” and will not sync with other photos even if Lock is turned on.

If you wish to remove a 
photo from the group, 
select it (by clicking on it 
or by pressing the left or 
right arrow keys) and press 
the / (slash) key on your 
keyboard. The photo will be 
removed from the Compare 
window, and the remaining 
photos will resize to best fill 
the available space in the 
window. (You can also add 
additional photos to the 
Compare window by using 
the selection techniques 
mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There are two exceptions:

• Using the Sync settings button on the far right side of the Browse window, underneath the 
Info pane. Clicking on that will sync all of the Edit settings between the primary selection and 
all of the items being compared.

• Using the Create Album or Add to Album commands from the Albums menu: this adds all of 
the currently selected photos to either the new album (when you check the Add Selected 
Items button) or to the chosen album. This feature can be helpful when you have a group of 
images that you would like to keep for a client or to further segment a series.

Zooming into a photo, and panning to the common areas of concern, you can easily determine which photo is 
sharp enough for your needs.
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WORKING IN MAP VIEW

Keyword AI’s Map view provides a simple mechanism to add GPS information to a photo, by searching 
for a place on a web-based map, or to view the location of a photo that already has location information 
embedded in its metadata. An internet connection is required to add or view map data.

The Map display has three controls: the buttons in the upper left corner of the map, to switch between 
Street, Satellite and Outdoors (topographic) views; a search area, which lets you look for a place (cities, 
counties, roads); and the controls on the lower left, which let you zoom in or out of the current map view. 
To move around the current view, click and drag inside the window. The filmstrip displays other photos 
in the current folder. To move between photos you can use the arrow keys, or you can use the mouse to 
select a new photo.

To view the location of any GPS-tagged photo on a map, select the photo and click on the Map view icon at 
the bottom of the main Browse window.

To add GPS data to a photo, select a photo or group of 
photos and click on the Map view icon at the bottom of 
the screen. There you can search for a location via the 
search bar. Once you have the desired area, right-click on 
the map to add a location for the photo (or photos) in that 
spot. If the position is correct, click inside the pop-up box 
to set the pin. 

If you would like to choose a different point instead, right-
click in another location. 

Keyword AI’s Map view can display the coordinates of a selected photo, or let you add GPS coordinates by clicking specific places on a map.

Right-clicking on a spot on the map will generate this pop-up. 
To confirm the location, click in the box; otherwise, you can 
right-click elsewhere to choose a different location.
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Once added, Keyword AI will enter that position in the GPS field of the Metadata panel. 

Keyword AI can also look up standard location information — city, 
state, country — from the GPS coordinates in a photo, and populate 
that information in the Location tab of the Metadata pane (shown 
on the right). To do this, click on the photos you wish to update and 
choose Set Location from GPS Coordinates from the Photo menu. 
(See “Metadata Pane” on page 24 for more information.)

Importing Photos into Keyword AI

ON1 Photo Keyword AI’s Import function lets you quickly grab photos directly from your camera, memory 
card, phone, tablet, or other source location (like a portable hard drive loaded with images from the field).

To import photos, connect your camera, card or other device and choose Import from Keyword AI’s File 
menu. The Import window opens, with the following options:

A.	 Import Options Bar: Lets you choose the source (camera, memory card, or other device), if 
Keyword AI should search through subfolders on the source, eject the device after importing, 
and to bypass images that have already been imported. You can also choose options for 
selecting all photos or none of them.

B.	 Preview window: Displays the images to be imported. By default, all photos are included; 
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click the check mark in the corner of any image to remove it from the import process.

C.	 Thumbnail size: Adjusts the size of the thumbnails in the preview area. 

D.	Preset selector: Applies an import preset—which can include any of the settings from the 
import panel on the right—to the currently selected images.

E.	 Destination: This pane sets the location of the imported images, as well as a secondary folder 
that you can use to store a copy of your photos saved as a backup to another location. (See 
below for specifics on using this pane.)

F.	 Rename: This pane lets you rename the imported files, with options for custom text, 
serialization, and image metadata. (This pane uses the same token-based renaming function 
and presets found in the Rename Files dialog; see page 41 for more.)

G.	Add Metadata: Lets you add assorted metadata to the imported images, ranging from 
keywords, copyright information and more. To access the complete IPTC metadata fields, 
click the More drop-down; you can also add GPS coordinates and a description via this  
section of the pane. You can use existing metadata presets (or create your own in this 
window) to apply consistent metadata across multiple imports; simply enter the data you wish 
to include and choose Save New Preset from the Preset menu in the pane. (See “Metadata 
templates” on page 25 for more on metadata presets.)

H.	Edit Capture Date: Use this pane when you wish to change the capture date of imported 
images. The Adjust Time Zone setting can be helpful if you forget to change your camera’s 
clock when you travel across multiple time zones.

Once you have adjusted your import settings and 
selected the images for import, click on the Import 
button to perform the operation. While your photos are 
being imported, you’ll see a progress bar displayed in 
the lower right side of the Browse window. If your import location is a cataloged folder, the new images will 
be indexed automatically in the background.

DESTINATION PANE OPTIONS

Destination is the only pane in the Import window that you 
have to set up when importing images. It has a number of 
different options for where you wish to import images:

• Use the Folder pop-up to choose the destination 
for your import. Recently used destinations will be 
in the list, or you can choose a different folder.

• To put your imported images into a new folder—
one that you name—inside the primary import 
location, enter the name of the new subfolder in 
the Put in Subfolder field. Keyword AI will create 
that folder and import the images to that location.

• Turning on the Secondary Folder option will copy 
the imported images to another folder connected to your computer (using the parameters 
in the Put in Subfolder and Generate Subfolders settings, if used). It is intended for people 
who wish to back up their photos onto another drive or location. Use the pop-up menu to 

While Keyword AI is importing images from a camera or card, you’ll 
see a progress indicator at the bottom of the Browse window.
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determine the backup location; any previously used folders will be listed in the menu.

• Use the Generate Subfolders option if you would like to use image metadata or import count 
information to create customized subfolders during import. This option uses the same token-
based function used in the Rename pane; see “Renaming Files and Folders in Browse” on 
page 41 for specifics on using these tokens. For example, you could have imported photos 
automatically organized by two levels of folders, one by year, and inside each year, folders for 
each month. When images are imported, Keyword AI will place each image in the appropriate 
location based on the settings in this field, creating the folder if it doesn’t exist.

Each time you import images, Keyword AI will display your previous settings.

BYPASSING DUPLICATE FILES DURING IMPORT

The Don’t Import Duplicates option is helpful for those times when you re-
use a card in the field, but don’t delete the photos from it.

Each time you use the Import function, Keyword AI keeps a record of every 
imported photo’s filename and capture time. When you add a card to import, 
the app checks its import database, and if it finds a duplicate, it will uncheck 
it in the Import window, and display an “Already Imported” icon to the right 
of the checkbox.  

Keyword AI saves the original filename and time metadata, so the Don’t 
Import Duplicates option works even if you use the Rename option to 
rename the photos on import. And, if for some reason you wish to re-import 
a photo, you can click the selection check mark to re-import it.

SAVING IMPORT SETTINGS AS A PRESET

Keyword AI makes it easy to save often-used import settings as a preset: things like copyright and other 
metadata, file-naming conventions, import locations and more. To save an import preset, adjust the 
information and settings in any of the panes on the right of the Import window, and choose Save New 
Preset from the pop-up. Thereafter, when you choose the preset, it will apply those saved settings to the 
current import job. If you wish to change a setting for an existing preset, select the preset, make your 
changes in the panels and choose Update Existing Preset from the preset selector’s pop-up menu.

Keyword AI remembers the last-used import preset when you choose Import from the File menu.

Managing Files and Folders in Keyword AI

CREATING A NEW FOLDER

You can create a new folder from the right-click contextual menu in the preview area or selecting Add 
Subfolder in the Edit menu. This will create a new folder inside the selected folder; if you have files selected 
in the preview area, you also will get the option to move or copy the selected images into the new folder.

With the Don’t Import Duplicates 
option on, any photo that has already 
been imported will be deselected.



ON1 Photo Keyword AI User Guide	 Part 2: Working in Keyword AI	 41

DELETING A FOLDER

To delete a file or folder, click on it and press the Delete key or right-click and select ‘Delete’ from the 
contextual menu. Then, confirm that you wish to move the file to the trash. If you have multiple files and or 
folders selected it will move them all to the trash. If you make a mistake you can use the Undo command, 
although some files, like those on a network volume, are deleted immediately and cannot be undone.

COPYING AND MOVING FILES AND FOLDERS

You can copy and move files and folders in the ways you are accustomed to on your computer. You can 
select files and folders and use the Edit > Copy command to copy them to the clipboard and then Edit > 
Paste to paste them to new location, inside or outside of Browse. You can use this to copy a file or folder 
from one place to another or to attach an image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. Dragging and 
dropping a file or folder will move it if it is on the same drive or copy it to another drive. You can drag and 
drop in and out of Browse module.

SHOW IN FINDER/SHOW IN EXPLORER

To view a file or folder in the Finder (MacOS) or Explorer (Windows), right-click on an image or folder in the 
Preview area and choose Show in Finder or Show in Explorer from the pop-up menu.

CHANGING A FOLDER’S THUMBNAIL PREVIEW

By default, Keyword AI chooses an image from a folder to use as the preview thumbnail for that folder. 
To change this, double-click on the folder icon and select a photo you would like to use as the thumbnail. 
Right-click on the photo and choose Set Folder Preview from the pop-up menu. 

RENAMING FILES AND FOLDERS

Browse offers two methods for renaming files or folders 
inside ON1 Photo Keyword AI: single file and batch. 

To quickly rename a single file or folder, click on it in most 
Browse views and choose Rename File from the Edit menu, 
or right-click on the item and choose Rename File from the 
pop-up menu. This will display a window where you can type 
in a new name for the item. Clicking OK will rename that file 
or folder.

Batch-renaming groups of files or folders

To rename multiple items in Photo Keyword AI as a batch, select them in the current view and choose 
Rename File from the Edit menu or the right-click contextual menu. Keyword AI will display the Rename 
window, which offers an array of options for renaming files based on custom text and image metadata.

In batch-rename mode, the Rename window has a central text entry field, where you can add any custom 
text you wish all of the renamed files to have. You can also insert a set of tokens (via a pop-up menu) that 

Renaming a single file or folder.



ON1 Photo Keyword AI User Guide	 Part 2: Working in Keyword AI	 42

will be added to the renamed files. These tokens are in four main groups:

• Filename, which includes options for 
using the original filename, number 
suffix (taken from the image as 
recorded by the camera) and enclosing 
folder name.

• Date/Time, which includes a list of 
date (year, month, day) and time data 
that can be combined in various ways.

• Sequence, which adds an incremented 
number to each renamed file in the 
batch, as well as the total number of 
files in the batch. Each of these token 
sets include options for leading zeros 
in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

NOTE: A complete list of the tokens used in the Rename window, with 
descriptions, can be found on page 56, in the Export section of this guide.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Keyword AI will rename all of the files.

The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Finding and Filtering Images with the Search Bar
Photo Keyword AI’s Search bar is designed to help you find photos in your photo library based on a 
extensive variety of criteria specific to photos and the metadata embedded in them. You can search based 
on any text associated with a photo; likes, labels and star ratings; dates, including creation and modification 

When renaming multiple files or folders, Keyword AI ‘s batch-rename feature 
lets you use complex combinations of custom text and image metadata. You 
have the capability to save your custom rename settings as a preset to reuse at 
other times.
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dates, time of day and seasons; keywords (including AI-generated keywords); and nearly any piece of 
metadata, from camera body and lens information to aperture, ISO settings, and much more. 

Search options are flexible: they can be applied to the current folder view or album, or they can search any 
or all of your cataloged folders. You can also save any search as a preset style, so you can use it again in the 
future, or you can save your search (of cataloged folders only) as a Smart Album that is available in the My 
Catalogs panels.

The Search bar is always available at the top of the main Keyword AI window. By default, Search is turned 
off, but you can turn it on by clicking on any of the four buttons in the center of the bar:

• Text: Searches for text associated with a photo. By default, it will search all text options, but 
you can use the menu to filter by a photo’s description, filename, keywords or title.

• Attribute: Searches for files based on likes/dislikes, ratings, color labels, and file type. (The 
Edits pop-up isn’t applicable inside Photo Keyword AI.)

• Faces: Searches for photos with one, two or a group of faces, as well as age categories (Baby/
Toddler, Chile, Teenager/Young Adult, Adult, and Elderly) and gender. These options will only 
find photos that have been scanned by the Keyword AI process, and have the Find Faces 
options turned on in the Preferences’ Keyword AI tab (see page 84).
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• Metadata: Let you create complex searches based on a broad set of metadata criteria and 
conditions. See page 45 for more information about the search fields available and using 
the different operators to create complex searches. 

To turn on option on, click on the button in the Search bar; to turn it off, click on the button again. You can 
also use combinations of the various options to create complex searches.

Keyword AI’s Search bar is dynamic: as you adjust the options in the window, the selection of photos that 
meet your criteria and other settings will be displayed in Keyword AI’s main window, in Grid view. If you 
add or remove criteria, change the source folders, the thumbnail grid will update.  

To stop the current search and return to the previous view, click None in the Search bar or click to close the 
Search Results overlay in the main window.

SEARCH BAR OPTIONS

The pop-up menu to the right of the Search label instructs Keyword AI where to search. The menu lets 
you choose between the photos in the current view (the default option); cataloged folders (all, or a specific 
folder): all photos that Keyword AI knows about (cataloged, favorites, and images in any folders you’ve 
viewed). When you have Current Photos selected as a source, the pop-up will have a Lock Search Across 
Folders option; choosing this will keep using the search criteria as you move from folder to folder.

To the right of the search options are three icons:

• Sort: This sorts the photos in the current view. The sorting options include: date captured or 
modified; color label; file name, type, or size; and rating. You can also create a custom sort 

The five Search bar options include, from top to bottom, None, Text, Attribute, Faces and Metadata. By default, the Keyword AI Search bar is off 
(set to None). To initiate a search of any type, you can click on one or all of the buttons in the center of the bar (bottom). To turn the search off, click 
on the None button, which will return the bar to the default state.
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order by dragging thumbnails inside the grid window; click and drag the thumbnail so that the 
outline sits between two images.

• Create Smart Album: When searching across cataloged folders, you can save a custom search 
as a smart album (see page 22).

• Smart Organize: This opens the Smart Organize window, where you can search for duplicate 
photos, photos of similar appearance, or photos taken at similar times or places (see page 
42).

SAVING SEARCH CRITERIA

You can save your searches to reuse at other times via the Save Styles menu 
at the far right of the Search bar. Set your search to the state where you 
would like to save it, and choose Save New Style from the menu. If you make 
changes to your chosen style and would like to incorporate those changes into 
the style, choose Update Style with Current Settings from the same menu. 
You can also rename and delete styles from this menu.

If your search is specific to cataloged folders, you can also save those 
searches as a Smart Album, either by clicking on the Smart Album icon in 
the Search bar, selecting Save as Smart Album from the pop-up menu in the 
Search bar.

SETTING THE SEARCH CRITERIA

The Search Criteria section consists of two parts: the matching options, and the criteria the search is 
using to find photos. The Match options set how you wish the search criteria to be filtered, based on three 
options: choosing photos that meet all of the current criteria, those that meet any of the criteria, or those 
that match none of the criteria.

You build the search options by adding criteria from the Add Field pop-up, using as many criteria as you 
wish to achieve your chosen search results. When you add a 
field, the default is Everything, which searches every piece 
of text-based metadata in your photos. You can change it by 
choosing another field from the pop-up menu. If you wish to 
remove a criterion you’ve added, click the ‘x’ on the right 
side of the item.

Search fields 

The Search bar’s Metadata menu has 19 categories of 
search criteria, wit additional subcategories. The categories, 
and what they search for, are:

• Album — whether a photo is in an album or not 
(Smart Albums are not supported).

• Camera — searches for specific camera and 
lens metadata used to take a photo, including 
aperture, shutter speed, ISO, focal length, camera 
name, and more.

The Search bar style menu..

There are 19 categories of search criteria in the Search bar. 
When you click the Add Field button, the default field is 
Everything; click on the pop-up menu to change it to a 
different search field.
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• Cloud Sync — not applicable in Photo Keyword AI.  

• Color Label — photos with a specific color label (icon and text name); can search for multiple 
labels as well (i.e. Red and Green).

• Date — capture date, edited date or time of day (morning, afternoon, evening, night) of a 
photo.

• Description — searches the contents of the Description field in the Metadata pane

• Edited — not applicable in Photo Keyword AI.  

• Everything — searches for any text-based data (filename, keywords, metadata information) 
associated with a photo.

• File Type — searches for specific image and video file types. Image formats include RAW, 
TIFF, PNG, JPEG, PSB, PSD, DNG, ONPHOTO, and HEIC. Video formats include M4V, MOV, 
AVI, WMV, MPEG, and MTS.

• Filename — filename or the folder path that the photo resides within.

• IPTC — searches IPTC-specific fields—as shown in the Metadata pane—including Copyright 
Status, Creator/Author, Job Identification, and Title. 

• Keyword AI — only searches for AI-generated keywords, as well as whether there are 
keywords attached to an image or not.

• Keywords — searches for both AI-generated and manually applied keywords, as well as 
whether there are keywords attached to an image or not.

• Likes — photos set with Like (icon with a filled-in heart), Dislike (‘X’ icon) or Not Set (empty 
heart).

• Location — draws from Location information section of the Metadata pane, can also search 
for photos with or without GPS data.

• Object Type — whether a file is a Photo or Video (Versions are not supported in Keyword AI).

• Metadata Changed  — whether the metadata for a photo is Unknown, Up to Date, or 
Changed.

• Rating — photos with a star rating set.

• Season — searches date information for photos shot during Spring, Summer, Winter, or Fall; 
includes Northern and Southern Hemisphere options.

• Shared — searches for photos that have been shared to SmugMug.

• Size — searches for photos based on size information, including file size on disk, height and 
width, long and short edge, number of megapixels, and orientation (landscape, portrait, 
square).

Search field operators

Each search field has an operator option and a subject field. Fields where the subject field is a list of items—
Edited, File Type, Likes, Object Type, and Shared—have a simple, “is/is not” binary set of operators. Search 
fields that have a text- or numeric-based subject field will have additional operators that let you refine the 
search in very specific ways:
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• “is/is not” will look for the exact match of the subject in the search field.

• “contains/does not contain” will look for matches that at least include the subject in the 
search field.

• “starts with/ends with” will look for matches where the text of the subject field is at the 
beginning or the end of the target. This is most often used when searching filenames, but it 
also is available in any metadata subject that has a text entry.

• “is empty/is not empty” is used to determine whether the contents of a metadata field 
contain information or not, and can be helpful when finding which photos in your library 
don’t have GPS information, or a color rating. 

• “is greater than/is less than” is used when the subject field being searched for contains 
numeric data. This operator is commonly used when searching ratings, but can be used in 
many other search types, especially with camera-specific metadata. 

• “is in the range” is used to find numeric or date-based metadata that resides within a 
specified range.

Date-specific fields have a few other operators in addition to some of the operators mentioned in the 
previous section, including:

• “is/is not in the last” finds photos taken in the last number of specified days.

The simplest search operator is the “is/is not” operator. Here, we want to search for all RAW files in the 
current source set.. This operator set is used by any search field where the subject field is a list of items.
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• “is today/yesterday” finds photos taken on the current day or the previous day.

• “is in the last week/month/year” finds photos taken in the range specified by the chosen 
operator.

• “is repeated annually” will find all photos taken on a specific day, regardless of the year. This 
can be useful for finding photos taken on holidays, birthdays, and other recurring events.

Creating complex searches

While many of your searches might be simple ones—like finding photos from a certain date range, or 
ones with a specific keyword or rating—the real power of Keyword AI’s Search bar lies in its capability to 
perform complex, multilevel searches. You can use a many search criteria in the Search bar as you wish to 
achieve the desired results.

Or, if you wanted to look for raw photos from 2010 to 2015, with an ISO above 3200, that might benefit 
from ON1’s NoNoise AI, you could use the following criteria:

With the above search, you might have a lot of photos that could use NoNoise’s noise reduction 
technology, so you could save the search as a style (or smart album) so you can run it again at later date. 

You can even have multiple instances of the same search field with different search options, although in 
most cases you’ll need to make sure that you have Meet Any of the Search Criteria set in the Match pop-up. 
For example, if you wished to find all RAW files and all DNG files, you would add two instances of the File 
Type criterion, one for each type, and change the Match pop-up to “Any of the following rules.” 
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Using Smart Organize to Manage Duplicates and More
Keyword AI’s Smart Organize feature is designed to 
help you get an unwieldy photo library under control. 
When you have a large library that contains thousands 
of photos, it can be difficult to find duplicates, or to 
manage images that are similar in appearance or date 
and time. Or sometimes, you wish to group photos 
from HDR brackets, slices for building panoramas, 
or photos to be focus stacked. Not only can Smart 
Organize find duplicates, but it can find and group 
photos that have similar appearance, location or time. 
It can help you cull your library to find just the best 
photos in a series.

To access Smart Organize, click on the icon in the 
Shortcuts list or choose Smart Organize from the File menu. This will open the start-up window, which has 
two sections, Search Options and File Info. The top of the Search Options pane lets you choose which part 
of your photo library you wish to search:

• The contents of the current view in Browse 
(Current Photos);

• All of your cataloged folders;

• A specific folder selected via your operating 
system’s file/folder selection dialog box; or 

• Any one of your individually cataloged folders.

The second portion of the Search Options pane lets you choose which search mode to use. There are four 
search types:

• Duplicate Photos. This option looks for potential duplicate images, based on name, date 
taken, file size, and dimensions.

• Similar Appearance. This option uses machine learning to find photos that are similar to each 
other, looking at similar tones and colors. This makes it easy to group and sort through series 
of photos, such as portraits of different people.

• Same Time. Selects photos that were shot in the same general time frame. When you wish to 
group panorama slices or HDR brackets, you can use this option to group sets of images. 

• Same Place. Uses GPS data to display photos taken in the same general vicinity of each other. 

Clicking the Find button will perform the search, and open the Smart Organize Results window, as shown 
on the following page.

NOTE: When working with large collections of photos, Smart Organize can 
take quite a bit of time to display results.
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THE SMART ORGANIZE RESULTS WINDOW

The Smart Organize results window contains the following elements:

A.	Results: the total number of photos found, and the number of sets.

B.	 Group heading: displays the group number and the number of photos marked in that group.

C.	 Preview area: displays search results as grid of thumbnails, by group. 

D.	View Selector: zoom factor (top left); switch between Grid and Compare views (bottom left); 
file path for the currently selected photo.

E.	 Reject/Delete and Auto Mark settings. 

F.	 Group-specific options: let you create a new subfolder with the selected images: reject/
delete marked photos in the group: and Skip the group and remove it from the window.

G.	Search Options: includes the original search type, but you can also perform a new search by 
selecting items from the pop-up menus in the panel.

H.	Info Panel: displays EXIF and size information for the currently selected photo. Works 
identically to the standard Info panel in ON1 Photo Keyword AI (see page 23)

I.	 Settings Applied: shows all of the operations from the Edit module that have been applied to 
the current image (see page 10).

J.	 Close buttons: Reject/Delete All Marked closes the window and does either deletes/rejects 
the marked photos in all groups; Done closes the window without making any changes.
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Working through the search results

When you perform a search with Smart Organize, the results window is organized into groups, based on 
the search mode you chose. Groups can consist of a pair of photos, or larger numbers, based on your library 
and the type of search. You can use the view slider of the window to make the thumbnails larger or smaller, 
and you can view the photos in Grid or Compare modes (see page 31 and page 35, respectively), 
which work in the same manner as those views in the main Browse window. 

The idea behind the results window is that you’ll work group by group, evaluating the photos in that group, 
and making decisions on the group’s contents based on the type of search you originally made. Photos that 
you wish to do something with—remove in one form or place into subfolders—you apply a checkmark to. 
Then, you’ll move on to the next group. The top section of each group has the following items:

A.	Group Information: Displays the number of the current group (out of the total number of 
groups) and the number of photos marked in the group. You can also use the right and left 
arrows on the left side of the bar to move to another group.

B.	 New Subfolder: Creates a subfolder with the marked photos in the group.

C.	 Reject/Delete All: This will apply the reject flag or delete all of the photos in the group, based 
on the Reject Mode option chosen at the top of the search results window.

D.	Reject/Delete Marked: This will apply the reject flag to, or delete all of the marked photos in 
the group, based on the Reject Mode option chosen.

E.	 Skip Group: Removes the group from the results, without making any changes.

In each group, you mark photos you want to deal with—ones you wish to reject/delete or move to a 
subfolder—with the checkbox in the upper corner of that photo’s thumbnail. You can select multiple photos 
in a group, and when you choose one of the actions, it will apply to the checked photos. Clicking on the 
New Subfolder, Reject/Delete All, or the Reject/Delete Marked buttons will apply that action to the group 
and remove the group from the results list. Clicking on the Skip Group button will remove that group from 
the results window and not make any changes to those photos.

When you’re using Smart Organize to look for and group photos—for HDR, panoramas, focus stacking, or 
other organizational uses, use the New Subfolder option. Mark the photos that you wish to group, and click 
on the New Subfolder button. You’ll be prompted for a folder name; enter the name and click OK. Keyword 
AI will move the marked photos to that new folder. 

NOTE: If the marked photos do not reside in the same folder the New 
Subfolder button will be grayed out.

Using Auto Mark

When you have the Auto Mark option checked at the top of the results window, Keyword AI will mark the 
photos in each group that it believes should be checked, based on criteria found in the Auto Mark tab of 
the Preferences window. This tab can be opened in the search results window by clicking on the gear icon 
to the right of the Auto Mark checkbox.
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The Auto Mark preferences tab displays a collection of 10 criteria—file type, editing status, various image 
metadata items, and more—that you can set, and that Keyword AI will utilize when performing a Smart 
Organize search. For example, you can choose 
to prefer Raw files over ONPhoto, JPG or PSD 
files, and, when creating each group, Keyword 
AI will mark—or not in the case of finding 
duplicate files—the appropriate images.

Auto Mark is intended to be an aid in helping 
you select and mark photos, especially when 
you’re dealing with large groups of photos. It 
doesn’t, however, automatically delete or reject 
photos; in each found group, you can choose to 
accept its recommendations, change them, or 
ignore them completely and skip that group. If 
you prefer to mark images in groups by yourself, 
simply turn the Auto Mark option off at the top 
of the results window.

Advanced search options

If you would like to perform a different search than the one 
currently displayed in the Smart Organize results window, 
you can do so via the Search Options pane on the left side 
of the results screen. The top of that pane has pop-ups for 
the search locations and the four search types (duplicates, 
appearance, time and location). However, there are two other 
options you can change, depending upon the type of search 
operation you are making.

In all four search types, the bottom of the pane has a menu 
with three options related to the aspect ratio and size of the 
photos selected. You can choose to refine the selection to 
files of the aspect ratio, the same pixel dimensions, or none. 

When you are searching for photos based on similarity, time or location, an Advanced section will be visible 
in the Search Options pane. The three Advanced options (and which search type they work with) are: 

• Matching Level (Find Similar): This slider adjusts the results of grouped photos. The smaller 
the number, the less they have to match to be grouped. 

• Time Gap (Group by Time): This lets you adjust the time in between shots by which you wish 
images to be grouped.

• GPS Distance (Group by Location): Sets the range (in meters) by which location-based photos 
are grouped.

When you have set the parameters of your new search, click the Search button, and Smart Organize will 
generate a new results window.
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Editing Photos in Keyword AI

RATINGS, LABELS AND LIKES

Using a standard rating and label system, it is easy to sort and cull your favorites from the throw-away 
shots. Keyword AI offers three ways, aside from keywords and subfolders, to mark and group similar 
images. All of these methods may be set several ways: from the Photo menu, the right-click contextual 
menu, clicking the badges on the image thumbnail or in the footer of Image view. There are also keyboard 
shortcuts associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers 
often use five stars for their favorite images and one star 
for images they don’t want to keep, but you can use this 
system in whatever way works best for you. You can adjust 
the rating using the 1 through 5 keys on the keyboard. You 
can also clear the stars on any image with the ` (backquote 
or grave) key.

• Color labels: There are five color labels as well. Color 
labels are a great way to mark sub-sets of images for 
special handling. You can set the color ratings by pressing 
the following keys: 6 (red), 7 (yellow), 8 (blue), 9 (green), 0 
(purple).

• Likes: A common need for photographers is to mark their 
favorite images and the ones they want to delete. This is best accomplished with the Like 
classification. There are three options: Like (icon with a filled-in heart), Dislike (‘X’ icon) and 
Not Set (empty heart). By default, images are in the Not Set category until you change them. 
You can set your Liked images with the P keyboard shortcut, Dislikes with the X key, and clear 
settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Photo Keyword AI.)

TIP: You can change the information displayed in the image thumbnails via the 
Thumbnail Options function. See “Changing the thumbnail display options” on 
page 31 for more.

Use Auto Advance when culling your photos

Keyword AI’s Auto Advance feature—which can be turned on or off via the Photo menu—was designed to 
help you rank a group of images quickly: with Auto Advance turned on, apply a rating, color label or flag to 
an current image and Keyword AI will make the change and automatically move to the next image.

An example of a photo in Grid view with a 
ratings, color and favorite attached.
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SEND TO

Browse lets you send images you are viewing to other applications for 
editing. This is done via the Send to option, which is available from the 
right-click contextual menu or the Edit menu. Browse detects the following 
common photo managers or editors and lists the latest installed version:

• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos 
to. Simply select the Send to Other Application option. Then 
select the application you want to send your photos to. The 
application will be remembered and listed with your other 
Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will 
be presented with the Edit in dialog box from ON1 Photo 
Keyword AI. There you’ll have the option to send either the 
edited photo or the original, unedited image. If you choose 
to send a copy, you’ll have options for choosing the file type, 
color space, bit depth and resolution. If you use the same 
set of options every time, you can check the “Don’t ask me again” box in the window, and you won’t be 
prompted again.

The Edit In dialog, with the Copy Options section expanded.
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PART 3: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important tasks you’ll do on a regular basis 
inside ON1 Photo Keyword AI, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, or 
printing to your desktop printer, Keyword AI has all the functionality you’ll need to get your photos where 
you want them to be. 

In this section, you’ll find detailed information on the following topics:

• Export: The power of ON1’s Resize technology in a quick and easy-to-use panel, letting you 
export your photos with flexibility, ease and control. (See page 56)

• Print: Print your photos in any size, as individual photos, or in contact sheet form. (See page 
67)

• Share: A quick way to share your photos via SmugMug. (See page 73)

• Send To: Edit photos in other photo apps. (See page 74)
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EXPORT
Export is a special function in Photo Keyword AI, giving you much of the power of ON1’s 
powerful Resize technology in an easy to use panel, letting you export your photos with 
incredible flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The 
Options panel contains specific types of options—file renaming, destination folders, file type and more—
that you can use when you are exporting images from Keyword AI. If you find that you are using a specific 
set of options all the time for your workflow, you can create a preset and apply that whenever you use 
Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.
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B.	 Save Preset: Lets you save the current set of export options as a preset.

C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. (not available when exporting from the Resize AI module) 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Keyword AI.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch, with options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Keyword AI will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on page 64.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the exported file’s name, preserving both files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Keyword AI completes the exporting 
process. Options include displaying the image location in the MacOS Finder or Windows 
Explorer, to create a ZIP archive of the exported group, to open in another editing application, 
or to run a script.
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FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Keyword AI can 
export in DNG, PSD, TIFF, JPG and PNG 
formats. With the exception of DNG and PNG, 
each file format has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using ON1’s 
Resize AI technology. It has seven options for 
export: Dimensions, Long and Short Edge, Width 
and Height, Megapixels and Percentage. Each 
option has a different range of settings, and 
all have a setting for resolution (in pixels per 
inch, or ppi), as well as a Don’t Enlarge option, which, when set, will not upscale a file past its native image 
dimensions (but will still export the file).

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock to resize the images proportionally as you enter either the width or the height, or, if you wish 
to fit the images to an exact width and height, click the lock icon to turn it off. If an exported image doesn’t 
exactly fit the dimensions you set for Width and Height, Export will do one of two things, depending upon 
whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the Resolution box.

• Fit in Dimensions will fit the file inside the boundaries of the width and height settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the 
width and height settings, essentially cropping the exported image. If the image’s aspect ratio 
is different from the width and height settings, the image will be filled from the center. 

The Resize pane, with the Dimensions option open.
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The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

The metadata information exported is the same 
data found in the Metadata pane in Browse, and any metadata presets you have saved will be available 
from the Presets pop-up menu. For specifics on the different types of data represented in the Metadata 
pane, see page 24. 

When checked, the Remove Unmanaged XMP button only exports metadata that is represented in 
Keyword AI’s Metadata pane; any other unmanaged image metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 7), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 
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Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders 
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the 
final image.

The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 57), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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from the Presets menu, make your changes, and choose Update Preset with Current Settings from the 
Presets menu. You can also rename and delete watermark presets from this menu.

Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all of 
the other panes alone, and click Export. Keyword AI will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Keyword AI 
will ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.



ON1 Photo Keyword AI User Guide	 Part 3: Output and Sharing	 64

About Keyword AI’s File-Naming Tokens
When using the Naming option in the Export window—or with Browse’s Rename File (page 41) and 
Import Photos (page 38) functions—Keyword AI includes a broad set of tokens that you can use as part 
of the strings to build complex file names, in conjunction with any custom text you wish to enter. These 
tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC metadata fields, and 
can be used in any number of combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

You can use a combination of tokens and custom text to rename files (in Export or Browse) to exacting 
specifications, all drawn from file information, metadata and more.
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DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

SEQUENCE NUMBER

The Sequence Number tokens come into play when 
exporting, importing or renaming a group of image files. 
There are essentially two tokens here, Sequence and Total, 
with options for padding zeros into each item. Sequence will 
take the group of images being worked on and, starting with 
the first item in the selection, will start at 1 and increment 
by one as each image is processed. The Total token will 
always be a single number—the number of items in the group 
being processed.

The combination of Sequence and Total tokens lets you 
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Keyword AI. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.
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Camera

The Camera submenu includes 21 items, all of which are directly 
taken from an image’s EXIF data. Not all cameras capture all 
of the items listed, but most of them save essential items like 
exposure information, focal length and more.

To look at the available camera information of any image, click the 
EXIF tab in Browse’s Metadata pane (page 24).

Ratings and Labels

The three tokens in the Ratings and Labels submenu pull 
information from any rating, label and like information you’ve made 
to images in Keyword AI.

The Rating token will add the number of stars an image is rated, 
while the Label token will add any color label information (red, 
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. All of these fields are visible in the IPTC tab of the Metadata pane in Browse (page 
24), and can be added during the import process as well. 

Using IPTC information makes the most sense when you have a strict method for importing and 
categorizing image data during import (or shortly thereafter).
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PRINTING
ON1 Photo Keyword AI has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module at any time. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo or photos being printed.

B.	 View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C.	 Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D.	Page view: Displays the number of pages being printed, and lets you move from page to page.

E.	 Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F.	 Print Area pane: Contains options for fitting and selecting the print image size.

G.	Watermark pane: For adding a watermark to printed photos.

H.	Sharpening: Options for sharpening during the print process.

I.	 Print/Cancel: Print One (current image), Print All, or Cancel.
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Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that 
has between 240 and 360 ppi. (Keyword AI will use its internal 
resampling engine to ensure that your photo is at the print 
resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. 

NOTE: Keyword AI’s Print feature will work with borderless printing options 
as well. Be sure to choose your printer’s borderless options in the page setup 
pop-up. Different printers will have specific borderless settings, so check the 
manual to see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Keyword AI will ask you for a filename and a location to save the 
file. Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When 
you choose Print, Keyword AI will create a PDF of the photo (or photos) and save it with the name and 
destination you specified earlier.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save as New Style from the menu. You’ll then 
be able to recall that style from the More pop-up whenever you print.

If you are printing multiple photos, Keyword AI will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position.

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to 
be at least 600 pixels wide. Otherwise, it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Basic printing with Keyword AI
Printing is available in any of Photo Keyword AI’s view modes; clicking the Print icon will open the Print 
window with the current image, or images, if there are multiple photos selected.  

If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, and click the Soft Proofing icon underneath the preview area.

Use the Sharpening pane to add additional 
sharpening to your printed image.
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PRINTING MULTIPLE PHOTOS

To print multiple photos—as a package or contact sheet—select the images you wish to print from the Grid 
or Filmstrip views (in Browse or Edit), and click the Print icon. The photos you’ve selected will be displayed 
in the filmstrip at the bottom of the window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages,  click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

If you decide that you don’t want to print a photo, click the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 24 photos to 
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the 
preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking 
Print All will print the collection.	
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Printing contact sheets

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Keyword AI lets you add the filename as a caption underneath the 
printed photo. Click the button to the left of the label to turn this on or off. (We will be 
adding additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.
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SHARING TO SMUGMUG
If you are a member of the SmugMug photo sharing 
and hosting service, ON1 Photo Keyword AI offers 
an easy to use mechanism for posting one or 
multiple photos to the service. This is accessed via 

the contextual menu that appears when you right-click on a 
photo. The first time you access the service, you’ll receive an 
authorization window inside Keyword AI; fill out your account 
information and password, and then click on the Authorize 
button. 

Once authorized, you’ll be presented with a window that lets 
you upload your photo or photos. The window contains a 
handful of options:

• Click the “Use photo metadata” control to include 
the photos’ metadata for use in the title, caption and 
keyword.

• The Gallery pop-up lets you add the photos to an 
existing gallery, or lets you create a new gallery. 

• The Open Gallery link to the left of the pop-up will 
open the currently selected gallery in your default 
web browser.

• The Size pop-up has three options, full-size, and 
either 4000 or 2000 pixels (on the long side).

Once you have selected the appropriate options, click the 
Share button. Keyword AI will create high-quality JPEGs of the 
chosen photos and publish them to SmugMug.

More information about SmugMug can be found at smugmug.
com.

The first time you share to SmugMug, you’ll be asked to 
log in to your account, and verify that you want to let 
Keyword AI post to your galleries on the site.

When you post to SmugMug from Keyword AI, you can 
include metadata, choose the gallery to you want the 
photos to go into, and the size of the uploaded photos.
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SEND TO OTHER APPLICATIONS
ON1 Photo Keyword AI can send photos to other apps for editing, 
via the Send to option, which is available from the right-click 
contextual menu or the Edit menu. Keyword AI automatically 
detects the following common photo managers or editors and lists 
the latest installed version:

• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. 
Simply select the Send to Other Application option. Then select 
the application you want to send your photos to. The application 
will be remembered and listed with your other Send to options. 
(For example, if you use an email client you can add it to easily 
email photos.)

When you send an image to another application, you will be 
presented with the Edit in dialog box from ON1 Photo Keyword AI. 
There you’ll have the option to send either the edited photo or the 
original, unedited image. If you choose to send a copy, you’ll have 
options for choosing the file type, color space, bit depth and 
resolution. If you use the same set of options every time, you can 
check the “Don’t ask me again” box in the window, and you won’t 
be prompted again.

The Send To... section is available when you 
right-click on a photo inside Browse pop-up menu. 

The Edit In dialog, with the Copy Options section expanded.
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Menus
ON1 Photo Keyword AI (MacOS Only)

• About ON1 Photo Keyword AI 2023: Opens the About 
box, displays your version number. (In the Help menu on 
Windows)

• Preferences: Opens the preferences window. (This is in 
the Edit menu on Windows)

• Quit ON1 Photo Keyword AI: Quits ON1 Photo 
Keyword AI.

File Menu

• Browse Folder: Opens the browse dialog where you can 
select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures folder.

• Browse Desktop: Navigates to your desktop.

• Search by Text: Opens the Text tab of the Advanced 
Search toolbar.

• Import from device: Opens the Import window.

• Add Cataloged Folder: Lets you choose a folder to add 
to the Cataloged Folders section of the Folders pane.

• Copy to My Catalogs: Copy or move a group of selected 
photos to a specific cataloged folder.

• Remove Cataloged Folder: Removes the selected folder 
from the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager for 
importing and exporting backgrounds, presets, textures 
and more.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Smart Organize: Opens the Smart Organize window, 
which lets you search for duplicates, and images similar 
in appearance, date, or time.

• Send to (list): Sends your image to the selected 
application in the list.

• Group RAW Plus JPG: Stacks RAW and JPG pairs 
together, reducing clutter.

• Export: Opens the Export window.

• Export with Previous: Exports the current selection 
with the last-used Export setting, bypassing the Export 
window.
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• Print: Opens up the print window.

• Restore Data: Restores your Keyword AI system 
settings and environment to a previous backup.

• Back up Data: Backs up your current Keyword AI 
system settings and environment.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Select All: Selects all the images in the current folder.

• Select None: Deselects all the images in the current 
folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard to the current 
location.

• Duplicate: Makes a physical copy of the selected file, in 
the same location as the original.

• Rename Files: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the 
trash.

• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Keyword AI’s commands.

Album Menu

• Create Album: Creates a new album.

• Rename Album: Renames the currently selected album.

• Delete Album: Deletes the currently selected album.

• Remove from Album: Removes selected photo(s) from 
the currently selected album.

• Create Smart Album: Creates a new smart album, based 
on the current Advanced search criteria.
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Photo Menu

• Rating: Sets star rating (0 to 5 stars)

• Color: Sets the color rating of a photo (None, Red, 
Yellow, Green, Red, Purple)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time 
zone changes.

• Set Location from GPS Coordinates: Looks up the place 
name information from the stored GPS coordinates and 
embeds it in the appropriate IPTC metadata fields.

• Embed Metadata: Stores adjusted metadata to the 
selected photo. (Only applicable to certain file formats.)

• Automatically Embed Metadata: When checked, 
Photo Keyword AI will automatically add the adjusted 
metadata to the selected photo.

• Read Metadata from Photo: Reads the embedded 
metadata from a raw file, overwriting any data that 
might be in the XMP sidecar files. (Useful for times 
when the metadata appears out of sync with different 
apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved 
metadata preset.

• Refresh Preview: Rebuilds the preview of the selected 
images. (Helpful if there are issues that are causing an 
image to display incorrectly.)
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View Menu

• Bigger Thumbnails: Increases the size of the thumbnails 
in Grid view.

• Smaller Thumbnails: Decreases the size of thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip or 
Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in the 
window.

• Fit to Screen: Resizes your image on-screen, to fit it 
entirely in the preview window.

• Actual Pixels: Zooms in to the 100% view.

• Thumbnail View Options: Lets you  change the display 
of thumbnails in Grid view..

• Search by Rating: Filters images by star rating.

• Search by Label: Filters images by color.

• Search by Likes: Filters images by likes/dislikes.

• Sort: Sort by filename, date, rating, label and more.

• Sort Subfolders at the Top: When sorting, puts 
subfolders at the top of the grid.

• Show Subfolder Contents: Will display/hide the 
contents of subfolders when viewing cataloged folders.

• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Quality: Select from Fast (uses embedded JPG) 
or Accurate (builds preview from the raw photo).

• Preview Background Color: Change the preview 
background color.
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Window Menu

• Minimize: Minimizes ON1 Photo Keyword AI.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Full Screen Preview: Displays the current photo full-
screen, without any additional interface elements.

• Quick Slideshow: Displays the current group of photos 
in a slideshow, with customizable time and transition 
effects.

• Folders: Opens and hides the Folders pane.

• Albums: Opens and hides the Album pane.

• Recent: Not applicable in Photo Keyword AI.

• Info: Open and hides the Info pane.

• Metadata: Open and hides the Metadata pane.

• Keyword List: Opens and hides the Keyword List pane.

• Search Bar: Opens the Search toolbar.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/reveals the Browse Panel.

• Show Photo Panel: Hides/reveals the Photo Panel.

• Hide Panels: Hides/reveals both left and right panels.
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Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub. 

• ON1 Photo Keyword AI Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Keyword AI startup 
screens.

• Check for Updates: Checks the ON1 update server to 
see if you are running the current version; it notifies you 
about updates and will walk you through the update 
process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Keyword AI.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo Keyword AI (Windows Only): Opens 
the about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Photo 
Keyword AI.
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Preferences
Keyword AI has a number of system-wide settings that you can set via the Preferences window. To access 
Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences from 
the ON1 Photo Keyword AI menu (Mac) or the Edit menu in Windows.

The Preferences window has four tabs: General, System, Auto Mark and Keyword AI. The settings in each 
tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Keyword AI workspace, including 
background color, scrolling controls and more.

Font Size

Sets the size of the text in the basic Keyword AI 
workspace (labels, panes and pop-up menus) to 
one of three general sizes: Small, Medium, Large. 

When changing the font size, you must quit and 
restart Keyword AI for the new setting to take 
effect.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items in the Keyword AI interface.

Application Language

Lets you change the display language for Keyword AI. Auto will use your system’s default language.

Legacy Browse Tab

Checking this will change the separate My Catalogs and Browse panels to the single Browse panel. (See 
“My Catalogs and Browse Panels” on page 17.) 

Show Folder Previews

When checked, will display a thumbnail of an image from the enclosing folder in Browse.
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Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.

SYSTEM

The System tab displays performance-related 
characteristics of Keyword AI 2023.

AI processor

Sets the processing option for Keyword AI’s 
AI-based operations. By default, the option is 
set to Auto, which uses the best combination 
of system resources to process tasks. If you are 
noticing some performance issues with NoNoise, 
Sky Swap, or other AI-based tasks, you can try 
setting the options to either your CPU or your 
graphics card.

Memory Usage

• System Usage: Specifies the amount 
of RAM that is used by the application. The maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) used. The maximum (default) is 
80%.

Scratch Folder Location

Lets you move or reset your memory cache, to speed editing operations while you’re running Keyword AI. 
This is helpful if your system drive has limited space and wish to use a faster external drive as a cache. This 
cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize Keyword AI for your specific setup:

• Video Card Strength balances updating the preview of the image and the movement of 
brushes and gradient tool overlays. If your brush is sticking try turning it down. If you have a 
high-end video card try turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to 
improve performance of panning.
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• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, 
sharing and caching. This can greatly improve performance. It is on by default for systems 
that support it. It may be disabled on lower-end GPUs.

AUTO MARK

This tab lets you set the various criteria Photo 
Keyword AI uses when using the Smart Organize 
feature in Browse.  See “Using Smart Organize 
to Manage Duplicates and More” on page 42 
for details on how to adjust the Auto Mark 
settings to fit your needs.

KEYWORD AI

This tab is for adjusting the settings of the 
Keyword AI feature. By default, Keyword AI 
scans all of the photos in all of your cataloged 
folders, and builds keywords based on the 
subjects in the photos.   

The “Write Keyword AI Results to XMP” will 
write all of the AI-generated keywords found in 
the AI Keywords section of the Metadata pane.

You can tweak some of the parameters that 
are used to generate AI keywords during the 
scanning process. These options include:

• Location lookup for GPS metadata.

• Photographic and histogram properties.

• The number of faces in photos (One, Two or Group), with optional gender and age estimation.

• Objects and regions.

• Folder names.

For information on the Keyword AI feature, see “Getting Started with Keywording” on page 13.
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Backing up Your Work in Photo Keyword AI
To safeguard your peace of mind in the event of computer failure—or help you get set up quickly when 
you move to a new computer—ON1 Photo Keyword AI includes a back-up and restore function. While 
this feature will not back up your photos, it will back up the following items related to your Keyword AI 
installation:

• All preferences, references to cataloged folders and other basic settings for Keyword AI.

• Albums.

• Metadata changes made to images in Keyword AI, including keywords, ratings, labels, and any 
data added via the Metadata pane. 

• All styles used in ON1 Photo Keyword AI.

• All Extras, including any you have imported.

To back up your Photo Keyword AI system, choose Back Up Data from the File menu. The Back Up Data 
window will let you choose a location for your backups, and also let you set a reminder schedule (daily, 
weekly, monthly, or no reminder) for backups. When 
you click the Back Up button, Keyword AI will create a 
.onbackup file in your chosen location, with the date and 
time embedded in the filename.

To restore your system to the latest backup, choose 
Restore Data from the File menu. (Depending upon the 
situation, you might need to reinstall Photo Keyword AI 
first.) The Restore Data window will prompt you for the 
location of your backups, and will choose the most 
recent backup to restore from. (If, for some reason, you 
would like to use an earlier backup, just move the most 
recent one to another location on your hard drive.)

Clicking Restore will pull the information from the 
backup and apply it to your Keyword AI setup. During 
the restoration process, if Keyword AI can’t find the 
proper folders with your photos, it will present the 
Missing Folders window, with a list of each folder that it 
can’t find. You can click the Locate button to reconnect the folder, or you can click the ‘X’ to the left of the 
folder name in the window to remove it from Photo Keyword AI’s database. 

NOTE: Photo Keyword AI’s back-up feature will not back up your photos; you 
should use other methods to ensure that your photos are backed up in a safe 
place.
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